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Abstract: This article comprehensively discusses assumption tests in statistical analysis, including 
the steps to implement them using SPSS software, along with examples of statistical test outputs.  
Assumption testing is a crucial early stage in quantitative research because it determines the 
feasibility of selecting statistical analysis techniques, especially in distinguishing between the use of 
parametric and non-parametric tests. Normality, homogeneity, and linearity tests are presented 
practically in this article to make understanding easier, especially for novice researchers .  
Additionally, this article briefly mentions the types of hypothesis tests commonly used in quantitative 
research and their test classifications. The approach used in writing this article is library research, in 
order to strengthen the theoretical basis and enrich the discussion. Hopefully, this article can be a 
useful conceptual reference for students, researchers, and practitioners in applying statistical  
analysis appropriately, systematically, and in accordance with scientific procedures . 
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Abstrak: Artikel ini membahas secara komprehensif mengenai uji prasyarat dalam analisis statistik, 
termasuk langkah-langkah pelaksanaannya menggunakan perangkat lunak SPSS, disertai dengan 
contoh output statistik ujinya. Uji prasyarat merupakan tahap awal yang krusial dalam penelitian 
kuantitatif karena berfungsi menentukan kelayakan pemilihan teknik analisis statistik, khususnya 
dalam membedakan antara penggunaan uji parametrik dan non-parametrik. Uji normalitas,  
homogenitas, dan linearitas dipaparkan secara praktis dalam artikel ini untuk memberikan 
kemudahan dalam memahami terutama bagi peneliti pemula. Selain itu, artikel ini menyinggung 
secara ringkas jenis-jenis uji hipotesis yang umum digunakan dalam penelitian kuantitatif dan 
pengklasifikasian ujinya. Pendekatan yang digunakan dalam penulisan artikel ini adalah studi 
pustaka (library research), guna memperkuat landasan teoritis dan memperkaya pembahasan.  
Diharapkan, artikel ini dapat menjadi referensi konseptual yang bermanfaat bagi mahasiswa,  
peneliti, dan praktisi dalam menerapkan analisis statistik secara tepat, sistematis, dan sesuai dengan 
prosedur ilmiah. 
 
Kata kunci: uji prasyarat, uji hipotesis, parametrik, non-parametrik, spss. 
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PENDAHULUAN 

Dalam penelitian kuantitatif, pengujian hipotesis merupakan salah satu tahapan 

krusial untuk menarik kesimpulan berdasarkan data yang dikumpulkan. Uji hipotesis 

memungkinkan peneliti untuk menentukan apakah suatu pernyataan atau asumsi tentang 

populasi dapat diterima atau ditolak berdasarkan sampel yang dianalisis. Namun, sebelum 

melakukan uji hipotesis, terdapat serangkaian prasyarat yang harus dipenuhi agar hasil 

pengujian memiliki validitas dan reliabilitas yang tinggi. 

Prasyarat uji hipotesis mencakup berbagai aspek, seperti normalitas data, 

homogenitas varians, dan independensi data. Setiap jenis uji hipotesis, baik parametrik 

maupun non-parametrik, memiliki syarat tertentu yang harus dipenuhi agar hasilnya dapat 

diinterpretasikan dengan benar. Jika prasyarat ini diabaikan, maka kesimpulan yang 

diperoleh dapat menyesatkan dan mengarah pada keputusan yang tidak akurat dalam 

penelitian. 

Sayangnya, banyak peneliti pemula yang lebih berfokus pada pemilihan metode uji 

hipotesis tanpa mempertimbangkan validitas prasyaratnya. Padahal, pemenuhan prasyarat 

uji merupakan langkah awal yang penting untuk memastikan bahwa metode yang 

digunakan sesuai dengan karakteristik data yang dianalisis. Oleh karena itu, dalam artikel 

ini akan dibahas secara lebih mendalam mengenai prasyarat uji hipotesis, pentingnya 

pemenuhannya, serta dampaknya terhadap hasil analisis data dalam penelitian kuantitatif. 

Dengan memahami dan menerapkan prasyarat uji hipotesis secara tepat, peneliti 

dapat meningkatkan akurasi hasil penelitian serta menghindari kesalahan dalam 

pengambilan keputusan statistik. Oleh karena itu, pembahasan ini diharapkan dapat 

memberikan pemahaman yang lebih komprehensif mengenai langkah-langkah awal yang 

harus diperhatikan sebelum melakukan uji hipotesis dalam penelitian ilmiah. 

 

METODE 

Dalam penelitian ini, pendekatan yang digunakan adalah library research atau 

penelitian pustaka, yang bertujuan untuk menggali informasi yang relevan dengan topik 

yang dibahas melalui informasi kerangka berfikir dari sumber-sumber yang sudah ada, 

seperti buku, jurnal ilmiah, artikel, laporan penelitian, dan publikasi akademik lainnya.1 

Pendekatan ini dipilih karena sesuai dengan tujuan penelitian yakni mendalami bahasan uji 

statistik dari aspek uji prasyarat dan uji hipotesis dengan menelaah berbagai sumber untuk 

memudahkan pembaca memahami topik kajian.  

Adapun proses penulisan karya ilmiah ini dilaksanakan dengan awalan berupa 

memilih serta mengumpulkan data sebanyak-banyaknya yang berkesesuaian dengan topik 

bahasan, menganalisa dan mengadopsi isi, selanjutnya data diinput serta diinterpretasikan 

dengan mengutip dan memparafrase berbagai informasi dari sumber literatur, kemudian 

disusun secara sistematis dan terstruktur hingga menjadi sebuah karya yang bermakna. 

 

 
1 Afrizal, Metode Penelitian Kualitatif : Sebuah Upaya Mendukung Penggunaan Penelitian 

Kualitatif Dalam Berbagai Disiplin Ilmu (Depok: Depok: Pt Rajagrafindo Persada, 2015), 124. 

http://creativecommons.org/licenses/by-nc-sa/4.0/
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HASIL DAN PEMBAHASAN 

1. Uji Hipotesis 

Sebuah penelitian mengharuskan perencanaan yang matang dan terarah adapun 

pada penelitian yang khususnya penelitian kuantitatif dibutuhkan sebuah pernyataan yang 

mengarah pada asumsi atau prediksi dengan menyajikan jawaban sementara atas 

pertanyaan penelitian, yang diharapkan dapat memandu jalan penelitian, hal inilah yang 

dikenal dan disebut dengan hipotesis penelitian.2 

Sedangkan Uji Hipotesis merupakan salah satu percabangan dari Ilmu Statistika 

Inferensial yakni suatu cabang statistik yang digunakan untuk menganalisis data sampel 

dan membuat kesimpulan atau prediksi tentang populasi secara keseluruhan, statistik 

inferensial memungkinkan peneliti untuk menguji hipotesis, memperkirakan parameter 

populasi, dan membuat generalisasi berdasarkan sampel yang diambil.3 Biasanya 

digunakan untuk menguji kebenaran atas suatu pernyataan secara statistik untuk mencapai 

suatu penarikan kesimpulan yang nantinya akan diterima atau ditolak bergantung pada 

pernyataan tersebut.4 Adapun macam-macam hipotesis secara ringkas dibagi atas hipotesis 

deskriptif, hipotesis komparatif, hipotesis asosiatif, hipotesis kausal, hipotesis nol dan 

alternative.5 Namun dalam kuanti biasanya lebih digunakan Ho dan Ha/H1 sebagai 

hipotesanya. 

Adapun Uji hipotesis memiliki syarat ketentuan yakni dengan pembagian atas 2 jenis 

klasifikasi yakni Uji Hipotesis Parametrik dan Uji Hipotesis Non-Parametrik dengan 

pembagian arah uji didasarkan pada kategori uji distribusi yakni satu pihak ke kiri atau ke 

kanan (One-Tailed) serta uji dua pihak (Two-Tailed).6 Penggunaan statistik parametrik dan 

statistik non-parametrik sangatlah bergantumg pada asumsi dan jenis data yang akan 

dianalisis oleh peneliti.7 Sehingga yang dikatakan Uji parametrik ialah metode analisis 

kuantitatif yang didasarkan pada asumsi distribusi normal, homogenitas varians, dan 

linearitas data. Pendekatan ini digunakan untuk data berskala interval atau rasio, serta 

memungkinkan estimasi parameter populasi secara efisien jika asumsi-asumsinya 

terpenuhi. Sedangkan Uji Non-Parametrik merupakan metode analisis yang tidak 

memerlukan asumsi distribusi normal, dan umumnya digunakan untuk data berskala 

ordinal atau nominal. Pendekatan ini mengandalkan peringkat atau frekuensi, sehingga 

sesuai untuk data kecil, tidak homogen, atau mengandung outlier. 

Maka dari itu, peneliti sebaiknya sebaiknya menggunakan uji parametrik jika data 

berdistribusi normal, homogen, dan berskala minimal interval/rasio. Namun peneliti juga 

harus paham untuk meggunakan uji nonparametrik apabila data tidak normal, varians tidak 

 
2 Jim Hoy Yam dan Ruhiyat Taufik, “Hipotesis Penelitian Kuantitatif,” Perspektif: Jurnal Ilmu 

Administrasi 3, no. 2 (2021): 96–102. 
3 Andy Field, Discovering Statistics Using IBM SPSS Statistics (London: SAGE Publications., 

2017)  
4 Anuraga Gangga, Indrasetianingsih Artanti, Dan Athoillah Muhammad, “Pelatihan 

Pengujian Hipotesis Statistika Dasar Dengan Software R,” Jurnal Budimas, 3.2 (2021), Hal. 327–34  
5 Nizamuddin Et Al., Metodologi Penelitian; Kajian Teoritis Dan Praktis Bagi Mahasiswa  

(Bengkalis, Dotplus Publisher, 2021)  
6 Dian Kususma Wardani, Pengujian Hipotesis (Deskriptif, Komparatif dan Asosiatif), 1 ed. 

(Jombang, LPPM UNIVIVERSITAS KH.A WAHAB HASBULLAH, 2020)  
7 Ni Ketut Rapi, “Pengembangan Modul Statistika dengan Asesmen Berbasis CP untuk 

Meningkatkan Self-Efficacy dan Hasil Belajar,” Jurnal Pendidikan Fisika Undiksha, 12.2 (2022), hal. 
164–75  
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homogen, atau berskala nominal/ordinal. Untuk memudahkan memahami perbedaannya, 

dapat dilihat melalui penyajian data pada gambar berikut: 

 

 
Gambar 1. Ringkas Perbandingan Sederhana Uji Parametrik dan Nonparametrik 

 

2. Macam-Macam Uji Hipotesis 

Berdasarkan klasifikasian dan tingkat pengelompokan data uji, maka Uji Hipotesis 

dibagi atas 2 yakni Uji Parametrik dan Uji Non-Parametrik. Adapun pada masing-masing uji 

dijabarkan sebagai berikut: 

a. Parametrik Uji-t atau Test-t  

Uji-t atau dikenal juga t-test, merupakan metode uji statistik yang digunakan 

untuk membandingkan rata-rata antara dua kelompok yang tidak memiliki hubungan 

atau keterkaitan langsung. Ketidakterkaitan ini menunjukkan bahwa penelitian 

dilakukan terhadap dua sampel yang berbeda dan independen satu sama lain. Uji ini 

bertujuan untuk menganalisis perbedaan variabilitas antara kedua kelompok data. 

Sebelum melakukan pengujian, langkah awal yang perlu dilakukan adalah 

menentukan apakah kedua kelompok memiliki varians yang sama (equal variance) 

atau berbeda (unequal variance), karena hal ini akan mempengaruhi perhitungan 

dalam uji statistik.8 Uji Statistik t adalah suatu uji yang menunjukkan seberapa jauh 

pengaruh satu variable independent secara individual dalam menerangkan variabel 

dependen. Pengujian statistik t atau t-test ini dilakukan dengan menggunakan tingkat 

signifikansi sebesar 0,05 (α=5%).9 

 

b. Parametrik Tes-Z atau Z Test 

Uji z digunakan untuk membandingkan rata-rata sampel dengan rata-rata 

populasi ketika varians populasi diketahui dan ukuran sampel cukup besar (n ≥ 30). 

Uji ini didasarkan pada distribusi normal standar (z-distribution), yang lebih sesuai 

digunakan jika sampel besar, karena estimasi standar deviasi sampel lebih stabil. 

Istilah uji z (z-test) merujuk pada penggunaan z-score dalam distribusi normal untuk 

 
8 Retno Palupi, Diyan Ayuk Yulianna, dan SM Santi Winarsih, “Anal isa Perbandingan Rumus 

Haversine Dan Rumus Euclidean Berbasis Sistem Informasi Geografis Menggunakan Metode 
Independent Sample t-Test,” JITU : Journal Informatic Technology And Communication  5, no. 1 (2021): 
40–47. 

9 Riana Magdalena dan Maria Angela Krisanti, “Pengujian Independent Sample T-Test di 
PT.Merck, Tbk.,” Jurnal Tekno (Civil Engineeering, Elektrical Engineeering and Industrial 
Engineeering) 16, no. 2 (2019): 35–48. 
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mengukur deviasi suatu statistik sampel terhadap rata-rata populasi dalam satuan 

standar deviasi. Dalam konteks uji z, z-score berfungsi sebagai ukuran standar yang 

menggambarkan sejauh mana rata-rata sampel menyimpang dari rata-rata populasi. 

Nilai kritis dalam distribusi normal, seperti z-score sebesar 1,96 untuk tingkat 

signifikansi 0,05, menjadi acuan dalam menentukan batas keputusan dalam 

pengujian hipotesis. Rasio kritis ini, misalnya 1,96 untuk α = 0,05 dan 2,58 untuk α = 

0,01, berperan dalam menetapkan signifikansi statistik suatu temuan, sehingga 

memungkinkan peneliti untuk membuat inferensi yang lebih akurat mengenai 

populasi berdasarkan data sampel.10  

 

c. Parametrik ANOVA 

ANOVA (Analysis of Variance) merupakan metode uji statistik yang berfungsi 

untuk menguji signifikansi perbedaan rata-rata antar kelompok. Berbeda dengan T-

Test yang hanya membandingkan dua kelompok, ANOVA memiliki keunggulan dalam 

menganalisis lebih dari dua kelompok secara simultan, sehingga lebih efisien dalam 

penelitian dengan banyak variabel. Metode ini pertama kali diperkenalkan oleh 

Ronald Fisher, seorang pionir dalam bidang statistik inferensial. Secara umum, 

ANOVA diklasifikasikan menjadi One-Way ANOVA, yang digunakan ketika terdapat 

satu variabel independen, dan Two-Way ANOVA, yang digunakan untuk menganalisis 

pengaruh dua variabel independen terhadap variabel dependen.11 

 

d. Parametrik Regresi Linear 

Regresi adalah salah satu metode statistika yang mempelajari pola hubungan 

yang logis (ada teorinya) antara dua atau lebih variabel dimana salah satunya ada 

yang berlaku sebagai variabel terikat/dependen (variabel yang nilainilainya 

tergantung pada variabel lain dan merupakan variabel yang diramalkan atau 

diterangkan nilainya) dan yang lainnya sebagai variabel bebas/independen (variabel 

yang nilai-nilainya tidak tergantung pada variabel lain dan merupakan variabel yang 

digunakan untuk meramalkan atau menerangkan variabel lain).12 Analisis regresi 

digunakan untuk menelaah hubungan antara 2 variabel atau lebih, terutama untuk 

menelusuri pola hubungan yang modelnya belum diketahui secara pasti.13 

 

e. Non-Parametrik Chi-Square atau Chi-Kuadrat  

Chi merupakan suatu ukuran menyangkut perbedaan yang terdapat di antara 

frekuensi pengamatan dengan frekuensi teoritis/frekuensi harapan, digunakan untuk 

membandingkan frekuensi yang muncul pada kategori atau kelompok berbeda. 14  

Pengujian ini paling sering digunakan oleh peneliti umum pada penelitian kuantitatif 

normal. Sementara itu, uji Chi-square tetap memiliki keterbatasan, seperti 

sensitivitas terhadap ukuran sampel yang terlalu kecil atau besar, yang dapat 

 
10 Krishna Sharma et al., “Review Article on Parametric and Nonparametric,” World Journal 

of Pharmaceutical and Medical Research 10, no. 4 (2024): 72–75, www.wjpmr.com. 
11 Hasny Delaila Siregar et al., “Analisis Uji Hipotesis Penelitian Perbandingan Menggunakan 

Statistik Parametrika,” Al Itihadu Jurnal Pendidikan, 3.1 (2024), hal. 1–12  
12 Ibid. 
13 Ibid. 
14 Rapi. “Pengembangan Modul Statistika dengan Asesmen Berbasis CP untuk Meningkatkan 

Self-Efficacy dan Hasil Belajar.” 
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mempengaruhi keakuratan hasil.15 Oleh karena itu, interpretasi hasil uji ini harus 

dilakukan dengan mempertimbangkan konteks penelitian dan karakteristik data 

yang dianalisis. 

 

f. Non-Parametrik Kolmogorov-Smirnov (K-S) Test 

Uji Kolmogorov-Smirnov (K-S) adalah metode statistik nonparametrik yang 

digunakan untuk mengukur kesesuaian distribusi data dengan distribusi teoritis 

tertentu atau untuk membandingkan distribusi dua kelompok data. Dalam 

penerapannya, uji K-S satu sampel digunakan untuk menguji apakah suatu sampel 

berasal dari distribusi yang telah ditentukan, sementara uji K-S dua sampel bertujuan 

untuk menentukan apakah dua sampel independen berasal dari distribusi yang sama. 

Keunggulan utama uji ini terletak pada sifatnya yang tidak memerlukan asumsi 

distribusi tertentu, sehingga sangat fleksibel dalam berbagai analisis statistik, 

khususnya dalam penelitian yang melibatkan data kontinu satu dimensi.16 Dinamai 

setelah Andrey Kolmogorov dan Nikolai Smirnov menemukan formulasi ini. 

 

g. Non-Parametrik Mann-Whitney U Test (Wilcoxon Rank-Sum Test) 

Uji Mann-Whitney U (atau Wilcoxon Rank-Sum Test) adalah salah satu uji 

statistik nonparametrik yang digunakan untuk membandingkan dua sampel 

independen guna menentukan apakah terdapat perbedaan yang signifikan antara 

median kedua kelompok tersebut. Uji ini sering digunakan sebagai alternatif dari uji-

t independen, terutama ketika asumsi normalitas tidak terpenuhi atau ketika data 

berbentuk ordinal atau memiliki distribusi yang tidak normal. Prinsip dasar uji Mann-

Whitney U adalah dengan membandingkan peringkat (ranks) dari data dalam kedua 

kelompok dan menghitung apakah terdapat perbedaan yang sistematis dalam 

distribusi nilai antar kelompok. Pengujian ini digunakan untuk menguji kesamaan 

distribusi dua populasi yang saling bebas dengan asumsi bahwa distribusi dari kedua 

populasi bersifat kontinu. Jika perbedaan antara kelompok cukup besar, maka 

hipotesis nol (H₀), yang menyatakan bahwa kedua kelompok memiliki distribusi yang 

sama, dapat ditolak.17  Uji ini umumnya diterapkan untuk membandingkan 

karakteristik antara dua kelompok independen, terutama ketika variabel yang 

dianalisis bersifat ordinal atau kontinu.18 Namun, uji ini tidak dapat digunakan jika 

variabel tersebut berdistribusi normal. 

 

h. Non-Parametrik Wilcoxon Signed-Rank Test 

Uji Wilcoxon Signed-Rank adalah metode statistik nonparametrik yang 

digunakan untuk mengevaluasi perbedaan signifikan antara dua set data 

berpasangan. Uji ini sering diterapkan sebagai alternatif dari uji t-berpasangan, 

terutama ketika asumsi normalitas tidak terpenuhi atau data berskala ordinal. 

Pengujian ini dilakukan pada data berpasangan yang berasal dari populasi yang sama, 

dengan skala pengukuran minimal ordinal, di mana pasangan data dipilih secara acak 

 
15 Sharma et al., “Review Article on Parametric and Nonparametric.” 
16 Andi Quraisy, “Normalitas Data Menggunakan Uji Kolmogorov-Smirnov dan Saphiro-

Wilk,” J-HEST Journal of Health Education Economics Science and Technology  3, no. 1 (2022): 7–11. 
17 Teti Sofia Yanti, “Uji Rank Mann-Whitney Dua Tahap,” Statistika, 7.1 (2007), hal. 55–60  
18 Sharma et al., “Review Article on Parametric and Nonparametric.” 
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dan independen. Proses uji melibatkan penghitungan selisih antara pasangan data, 

pengurutan nilai absolut dari selisih tersebut, pemberian peringkat, dan penentuan 

tanda positif atau negatif sesuai dengan tanda selisih asli. Selanjutnya, jumlah 

peringkat bertanda positif dan negatif dibandingkan untuk menilai apakah terdapat 

perbedaan signifikan antara kedua set data.19 Keunggulan utama uji Wilcoxon Signed-

Rank adalah kemampuannya dalam menganalisis data tanpa memerlukan asumsi 

distribusi normal, sehingga memberikan fleksibilitas lebih dalam analisis statistik. 

 

i. Non-Parametrik Kruskal-Wallis H Test 

Uji Kruskal-Wallis adalah metode statistik nonparametrik yang digunakan untuk 

menguji apakah terdapat perbedaan signifikan antara tiga atau lebih kelompok 

independen terhadap variabel dependen yang berskala ordinal atau kontinu. Uji ini 

sering disebut sebagai uji Kruskal-Wallis H atau H-test dan berfungsi sebagai 

alternatif dari uji ANOVA satu arah ketika asumsi kenormalan tidak terpenuhi. Secara 

khusus, uji Kruskal-Wallis diterapkan untuk membandingkan lebih dari dua 

kelompok populasi dengan data yang berbentuk peringkat (ranking).20 Metode ini 

merupakan pengembangan dari uji Mann-Whitney yang memungkinkan analisis 

lebih dari dua kelompok independen. 

 

j. Non-Parametrik Friedman Test 

Uji Friedman merupakan teknik statistik nonparametrik yang digunakan untuk 

mengidentifikasi perbedaan signifikan di antara tiga atau lebih perlakuan dalam 

suatu eksperimen yang menggunakan desain blok lengkap (randomized complete 

block design). Merupakan uji yang juga disebut dengan Anova dua arah berdasarkan 

peringkat (two-way anova by ranks).21 Salah satu keunggulan utama uji ini adalah 

kemampuannya untuk menganalisis data berskala ordinal atau data yang tidak 

memenuhi asumsi parametrik.22 Oleh karena itu uji hipotesisi ini memberikan 

fleksibilitas dalam berbagai jenis penelitian dengan data non-parametrik.23 

 

k. Non-Parametrik Spearman’s Rank Correlation 

Korelasi Spearman merupakan metode statistik nonparametrik yang digunakan 

untuk menguji keterkaitan antara dua variabel dengan data berskala ordinal atau 

berbasis peringkat. Nilai korelasinya dilambangkan dengan ρ (rho) dan berkisar 

antara -1 hingga 1, di mana nilai 0 menandakan tidak adanya hubungan antara 

variabel yang dianalisis. Sebelum dilakukan pengujian, data kuantitatif yang 

 
19 Sri Indra Maiyanti et al., “Implementasi Wilcoxon Signed-Rank Test Univariat dan 

Multivariat Untuk Menguji Perbedaan Derajat Nyeri Pasien Endometriosis Sebelum dan Sesudah 
Tindakan Operasi,” SainsMath: Jurnal MIPA Sains Terapan 2, no. 1 (2023): 1–8. 

20 Witri Wardani Hulu et al., “ANALISIS KRUSKAL-WALLIS TERHADAP HUBUNGAN ANTARA 
GANGGUAN TIDUR DENGAN KUALITAS TIDUR,” Interdisciplinary Explorations in Research Journal 
(IERJ) 2, no. 3 (2024): 1640–1649. 

21 Harsih Rianto dan Romi Satria Wahono, “Resampling Logistic Regression untuk 
Penanganan Ketidakseimbangan Class pada Prediksi Cacat Software,” Journal of Software 
Engineering 1, no. 1 (2015): 46–53. 

22 Ibid. 
23 Fitri Catur Lestari, “Uji Bredenkamp, Hildebrand, Kubinger dan Friedman,” Jurnal Mat Stat 

9, no. 2 (2009): 135–142. 
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digunakan perlu diubah ke dalam bentuk peringkat agar sesuai dengan karakteristik 

uji ini. Selain itu, tanda positif (+) dan negatif (-) pada nilai korelasi 

merepresentasikan arah hubungan antara kedua variabel yang diuji, apakah searah 

atau berlawanan.24 Sehingga uji ini dapat Uji ini mengidentifikasi kekuatan dan arah 

hubungan monotonik antara dua variabel tanpa memerlukan asumsi distribusi 

normal. 

 

l. Non-Parametrik Kendall’s Tau 

Uji korelasi Kendall’s Tau adalah metode statistik nonparametrik yang 

digunakan untuk mengevaluasi hubungan antara dua kumpulan data berbasis 

peringkat yang berasal dari dua individu atau sumber yang berbeda. Uji ini bertujuan 

untuk menentukan apakah terdapat hubungan signifikan antara kedua variabel yang 

dianalisis, baik dalam arah positif maupun negatif. Dalam pengujiannya, Kendall’s Tau 

mengukur konsistensi peringkat antara dua variabel, di mana korelasi positif 

menunjukkan bahwa peringkat cenderung sejajar, sedangkan korelasi negatif 

mengindikasikan peringkat yang berlawanan.25 Dengan demikian, uji ini sering 

digunakan dalam analisis data ordinal atau ketika asumsi normalitas tidak terpenuhi, 

sehingga memberikan pendekatan yang lebih fleksibel dalam berbagai penelitian 

statistik. 

 

3. Uji  Prasyarat  

Dalam statistik, uji prasyarat dilakukan sebelum analisis data utama untuk 

memastikan bahwa asumsi statistik yang mendasari uji tersebut terpenuhi dalam arti lain 

uji prasyarat dilakukan sebelum uji hipotesis.26 Sebagaimana menjadi konsep dasar untuk 

menetapkan statistik uji mana yang diperlukan atau cocok digunakan dalam penelitian, 

serta apakah uji tersebut menggunakan statistik parametrik atau non-parametrik.27 Adapun 

uji prasyarat terbagi atas: Uji Normalitas; Uji Homogenitas; Uji Linearitas; Uji 

Multikolinearitas; Uji Autokorelasi; Uji Heteroskedastisitas. Dalam pembahasan makalah ini 

akan difokuskan dengan 3 scope utama yakni Uji Normalitas-Homogenitas-Linearitas yang 

umum dan dominan digunakan dalam penelitian. 

Secara berurut, dijelaskan bahwa Uji Normalitas merupakan uji Uji Normalitas 

digunakan untuk menentukan apakah data berdistribusi normal atau tidak dengan acuan 

yang ada.28 Jika data yang diperoleh berdistribusi normal maka hasil analisis dapat 

digeneralisasikan ke populasi yang ada dalam penelitian.29 Ini merupakan tahapan awal 

 
24 Yulia Yudihartanti, “Penentuan Hubungan Mata Kuliah Penelitian Dan Tugas Akhir Dengan 

Korelasi Rank Spearman,” Jutisi : Jurnal Ilmiah Teknik Informatika dan Sistem Informasi  6, no. 3 
(2017): 1691–1694. 

25 Kholilah Kholilah et al., “Hubungan Kerja Keras dan Hasil Belajar Fisika,” Journal of Science 
Education And Practice 4, no. 1 (2020): 41–48. 

26 Marzuki Noor, “Korelasi antara Kecemasan dalam Berhubungan Sosial dengan 
Prokrastinasi Akademik Peserta Didik SMA Negeri 1 Rumbia Lampung Tengah,” Counseling Milenial 
(CM) 1, no. 2 (2020): 94. 

27 Usmadi Usmadi, “Pengujian Persyaratan Analisis (Uji Homogenitas Dan Uji Normalitas),”  
Inovasi Pendidikan 7, no. 1 (2020): 50–62. 

28 Hermin Nurhayati dan Nuni Widiarti , Langlang Handayani, “Jurnal basicedu. Jurnal  
Basicedu,” Jurnal Basicedu, 5.5 (2020), hal. 3(2), 524–32. 

29 Noor, “Korelasi antara Kecemasan dalam Berhubungan Sosial dengan Prokrastinasi  
Akademik Peserta Didik SMA Negeri 1 Rumbia Lampung Tengah.”  
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dari pengolahan data penelitian sebelum menguji dengan pengujian lainnya (uji hipotesis). 

Selanjutnya Uji Homogenitas yang merupakan Uji Homogenitas digunakan untuk 

menentukan apakah kelompok data berasal dari kelompok yang homogen.30 Uji 

homogenitas bertujuan untuk menentukan apakah varians dari beberapa populasi bersifat 

sama atau berbeda.31 Dan yang ketiga ialah Uji Linearitas yang mana uji ini digunakan untuk 

menentukan apakah variabel independen memiliki hubungan yang signifikan secara linear 

terhadap variabel dependen. Dalam penelitian, keberadaan hubungan yang linear menjadi 

indikator penting dalam analisis statistik.32 

Uji normalitas memiliki beberapa rumus atau mode uji seperti Kolmogorov Smirnof 

(K-S), Shapiro Wilk, Lilliefors, Anderson-Darling, dan Skewness-Kurtosis (2 diantaranya 

menjadi paling dominan digunakan yakni K-S dan Shapiro). Adapun Dalam analisis statistik, 

uji homogenitas terdiri atas lima metode utama, yaitu Levene’s Test, Bartlett’s Test, Brown-

Forsythe Test, Hartley’s F-max Test, dan Fligner-Killeen Test (diantaranya Levene menjadi Tes 

yang paling sering digunakan dan atau Barlett’s test namun biasanya diganti dengan test Box 

M). Sedangkan uji linearitas terdiri atas lima metode utama, yaitu Analysis of Variance 

(ANOVA) Linearitas (Deviation from Linearity Test), Pearson Product-Moment Correlation, 

Linear Regression (Signifikansi Koefisien Regresi), Durbin-Watson Test, dan Scatter Plot 

(Pearson dan ANOVA menjadi uji yang paling sering dipakai dalam statistik). 

 

4. Langkah-Langkah Penggunaan SPSS Uji Prasyarat 

Untuk memberi data contoh pada bahasan Uji Prasyarat, penulis menyajikan data 

berupa angket tentang “PENGARUH GAYA MENGAJAR GURU TERHADAP KEAKTIFAN 

SISWA PADA PEMBELAJARAN PAI”33 yang disajikan dalam 2 buah angket dengan 

pendekatan likert 5 Opsi. Perlu digarisbawahi bahwasannya data angket sudah dilakukan 

uji kualitas terlebih dahulu yakni dengan uji Validitas dan Reliabilitas, Sehingga diperoleh 

angket yang kuat dan valid dengan N=43. 

 

a. Uji Kolmogorov-Smirnov (K-S) 

Buka SPSS (versi berapa saja)→Variabel View (isi variabel sesuai data 

penelitian)→Data View (isi nilai sesuai data yang diperoleh)→ Analyze → 

Nonparametric Tests → Legacy Dialogs → 1-Sample K-S→OK→Perhatikan hasil 

output yang dihasilkan→Interpretasikan data. 

 
30 Nurhayati dan , Langlang Handayani, “Jurnal basicedu. Jurnal Basicedu,.”  
31 Nurina Kurniasari Rahmawati, “Implementasi Teams Games Tournaments dan Number 

Head Together ditinjau dari Kemampuan Penalaran Matematis,” Al-Jabar : Jurnal Pendidikan 
Matematika 8, no. 2 (2017): 121. 

32 Tasya Raudatul Zikri dan Tumin Tumin, “Pengaruh Penggunaan Media Sosial TikTok 
terhadap Hasil Belajar PAI Peserta Didik di SMP Muhammadiyah 1 Minggir,” CENDEKIA : Jurnal 
Penelitian dan Pengkajian Ilmiah 1, no. 5 (2024): 221–230. 

33 Faisal Amir Toedien, Miftahir Rizqa, Dan Risnawati, “Kontribusi Gaya Mengajar Expert 
Guru Terhadap Keaktifan Siswa Pada Pembelajaran Pendidikan Agama Islam,” Potensia: Jurnal 
Kependidikan Islam 10, No. 2 (2024): 274–288  
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Gambar 2. Contoh output hasil uji yang dihasilkan dengan SPSS terkait uji normalitas 

 

b. Uji Shapiro Wilk 

Buka SPSS (versi berapa saja)→Variabel View (isi variabel sesuai data 

penelitian)→Data View (isi nilai sesuai data yang diperoleh)→ Analyze→Descriptive 

Statistics→ Explore→pindah semua variabel ke dependent List→Plots→ Normality 

plots with tests→continue→OK→Perhatikan hasil output→Interpretasikan data. 

 
 

Gambar 3. Contoh output hasil uji yang dihasilkan dengan SPSS terkait uji normalitas 

 

c. Uji Levene’s Test 

Buka SPSS (versi berapa saja) → Variabel View (isi variabel sesuai data penelitian yang 

sudah dimodif dengan menambahkan kode 1 dan 2 untuk label menjadikan xy satu 

variabel dan 1-2menjadi variabel pembantu kedua)→Isi values dengan label yang 

diinginkan → Data View (masukkan data yang diperoleh secara berurutan menjadi 

satu baris saja untuk x-y dan satu baris untuk label 1-2) → Analyze → Compare Means 

→ One-Way ANOVA → Masukkan variabel ke Dependent List → Masukkan faktor (label) 

ke Factor List  → Options → Ceklis Homogeneity of variance test (Levene’s Test) → 

Continue → OK → Perhatikan output yang muncul → Interpretasikan hasil. 
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Gambar 4. Contoh output hasil uji yang dihasilkan dengan SPSS terkait uji Homogenitas 

 

d. Uji Bartlett’s (Alternative: Box M) 

Alternative BOX M-Buka SPSS (fleksibel di semua Versi SPSS)→ Variabel View (isi 

variabel sesuai data penelitian yang sudah dimodif dengan menambahkan kode 1 dan 

2 untuk label menjadikan xy satu variabel dan 1-2menjadi variabel pembantu 

kedua)→Isi values dengan label yang diinginkan → Data View (masukkan data yang 

diperoleh secara berurutan menjadi satu baris saja untuk x-y dan satu baris untuk 

label 1-2→Analyze→ Classify→Discriminant→Independent list isi dengan x-y dan 

factor list isi 1-2→Define Range isi minimum 1 dan maximum 2 karna ada dua 

kategori→Menu statistic ceklis BOX M (alternative dari barlet)→Continue dan OK. 

 
Gambar 5. Contoh output hasil uji yang dihasilkan dengan SPSS terkait uji homogenitas 

 

e. Uji Deviation Linearity (ANOVA Linearitas Test) 

Buka SPSS (versi berapa saja) → Variable View (isi variabel sesuai data penelitian) → 

Data View (isi nilai sesuai data yang diperoleh) → Analyze → Compare Means → Means 

→ Pindahkan variabel dependen (Y) ke Dependent List → Pindahkan variabel 

independen (X) ke Independent List → Options → Centang Test for Linearity → Continue 

→ OK → Perhatikan hasil output di bagian Test for Linearity → Interpretasikan data 

berdasarkan nilai Sig. (p-value) pada baris Deviation from Linearity: Jika p-value > 0,05 

→ Hubungan dianggap linear. Jika p-value < 0,05 → Hubungan tidak linear, ada pola 

lain yang lebih sesuai. 
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Gambar 6. Contoh output hasil uji yang dihasilkan dengan SPSS terkait uji linearitas 

 

f. Uji Pearson Product Moment (korelasional) 

Buka SPSS (versi berapa saja) → Variable View (isi variabel sesuai data penelitian) → 

Data View (isi nilai sesuai data yang diperoleh) → Analyze → Correlate → Bivariate → 

Pindahkan kedua variabel (X dan Y) ke dalam kotak Variables → Pastikan opsi Pearson 

tercentang → Pilih Two-tailed atau One-tailed sesuai dengan hipotesis yang digunakan 

→ Centang Flag significant correlations jika ingin menandai korelasi yang signifikan 

→ OK → Perhatikan hasil output yang dihasilkan → Interpretasikan data. 

 
Gambar 7. Contoh output hasil uji yang dihasilkan dengan SPSS terkait uji linearitas 

 

SIMPULAN 

Berdasarkan hasil tinjauan pustaka dengan didukung dengan beberapa data yang 

signifikan, ditarik kesimpulan bahwa uji prasyarat merupakan tahapan awal dan sangat 

krusial dan harus dilakukan oleh peneliti dalam penelitian kuantitatif yang bertujuan untuk 

memastikan bahwa data memenuhi asumsi dasar sebelum dilakukan uji hipotesi. Sehingga, 

hasil analisis lebih dapat dipercaya dengan kevaliditasan datanya. Adapun uji prasyarat uji 

yang harus dilakukan ialah uji normalitas, linearitas dan homogenitas dengan asumsi jika 

Rhitung > Rtabel maka data dinyatakan memenuhi asumsi dan dapat dioperasikan dengan 

uji hipotesis parametrik, sedangkan jika Rhitung < Rtabel maka data dinyatakan tidak 

memenuhi asumsi dan perlu dilakukan operasi dengan uji hipotesis non-parametrik. 

Adapun hasil uji menggunakan SPSS dengan langkah-langkah yang telah disajikan akan 

menghasilkan output yang menunjukkan perhitungan signifikansi yang menjadi acuan 

sebagai Rhitung pada uji.  

Perlu digarisbawahi, uji prasyarat dan uji hipotesis (baik parametrik maupun non-

parametrik) ini dapat dilakukan menggunakan berbagai metode statistik sehingga peneliti 

dituntut mampu memilih teknik analisis yang tepat dan sesuai dengan karakteristik data 
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yang digunakan agar menghasilkan interpretasi yang akurat dan cermat. Oleh karenanya, 

artikel ini hadir sebagai tools bagi peneliti terlebih bagi peneliti pemula untuk lebih 

memahami tata cara olah data pada penelitian kuantitatif statistik menggunakan aplikasi 

berupa SPSS. 
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